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In this chapter you will learn how to:
★	 insert an image
★	 resize an image to maintain or adjust  

the aspect ratio of an image
★	 wrap text around an image
★	 place an image with precision
★	 place a border around an image

★	 rotate an image
★	 crop an image
★	 reflect an image
★	 adjust the brightness and contrast  

of an image
★	 group and layer images

In this chapter you will need the following source files:
★	 dog.png
★	 elephant.jpg
★	 remora.jpg
★	 robin.png
★	 snow.rtf
★	 snowangel.png
★	 snowball.jpg

★	 snowman.jpg
★	 text1.png
★	 text2.png
★	 text3.png
★	 trees.jpg
★	 winter.pptx

12.1 Software tools
You will need to know how to place image files into different application 
packages. Where this is required in a web page please refer to Section 21.2.7. 
Images are unlikely to be included in the spreadsheets and databases elements 
of the course. However, images will be placed in both word-processed documents 
and presentations. First you must select images appropriate for the document’s 
audience.

Task 12A
A short historical news article is to be given to young adults aged 15–25 to study.

Open the document snow.rtf. Insert the images snowball.jpg, snowman.jpg and 
trees.jpg at the end of the document.

This task requires a document rather than a presentation, although the methods 
shown are identical in both packages. Use the Search tool to find Microsoft Word 
and open this package.

From the File tab, select Open and locate and open the file snow.rtf. Replace the 
text <Your Name> with your name, centre number and candidate number. Create 
a new folder called Task 12a. Select the File tab, then Save As to save your 
document, in this folder, as a Word document (.docx) with the filename task12a.

Images

Link
See Chapter 21.2.7

12
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12.1 Software tools

12.1.1 Insert images in a document or presentation
Move the cursor to the end of the document. Select 
the Insert tab, followed by Picture. This opens the 
Insert Picture window. Browse through the folders 
and files until you locate the file snowball.jpg.

Click the left mouse button on this file followed by 
Insert.

This will insert the image at the end of the 
document. Repeat this process for the files 
snowman.jpg and trees.jpg. Save the document as 
task12a.

You will notice that the images are inserted where the cursor was placed, at the 
end of the document. These will now need manipulating so that they become a 
part of the document, rather than just added to the end.

12.2 Edit an image
It is important that an image included in any 
document, presentation or publication in any form 
should be appropriate to the subject matter. If a 
document was about the snow, you may expect to 
see an image like this.

Making choices
Read the question and text carefully to try and 
understand which image would be the best and 
why. Does this image need editing? Is the image 
the correct shape to fit the position you wish to 
place it? If the image needed to be in landscape 
orientation you would need to crop it. Where do 
you crop it? If you crop the top off the image the 
watering can on the wall will be lost, which gives 
the viewer an idea of the depth of the snow, but so 
do the bricks in the wall. Do you crop the bottom 
from the image and remove lots of the white snow? 
The choices are yours depending upon what message 
you want the image to give. Is it the depth of the 
snow? Is it the dog playing in the snow?

If this image needs to be in landscape orientation 
and no alternative image is available, then you must 
crop the image rather than compressing or distorting 
it. Images should retain the correct proportions 
between width and height; this is called the aspect 
ratio.
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12 Images

12.2.1 Resize an image
Resize an image in Microsoft Word
Find the image snowball.jpg in your document. 
Click the right mouse button on this image to get a 
drop-down menu. Select from this menu the Size and 
Position... option.

Advice
If the Size and Position… option does not appear, 
select Format Picture... followed by the Size tab.

This opens the Layout window which should be in 
the Size tab. If not select it.

The task instructs you to resize the image 
maintaining its aspect ratio. This means to keep the 
height and width in the same proportions as the 
original image, usually to ensure that you do not 
distort it. To do this, ensure that the two tick boxes 
related to the aspect ratio are both selected.

Change the Height of the image to 8 cm and click  
on OK.

Advice
Please note that you must ask for and be given 
permission to use an image in any publication. 
Copyright law in many countries will not allow you to 
use an image belonging to another person without 
their written consent.

Many copyright holders are happy for students to use 
their images for educational purposes without charging 
them, but you must obtain their permission to do so.

Task 12B
Open the file task12a.

Resize the image snowball.jpg to 8 cm high and 
maintain its aspect ratio. Place this at the top right of 
the first paragraph.

Resize the image of the snowman to 2.6 cm high and 
2 cm wide. Save the document as task12b.
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12.1 Software tools

Use a similar method to resize the clip-art image to 
2.6 cm high by 2 cm wide. Select the snowman image 
and open the Layout window in the Size tab for that 
image. In this case different lengths and widths have 
been specified, but you have not been instructed to 
crop the image. This means that you will probably 
distort the image from its original proportions. To do 
this, first, make sure that both of the aspect ratio 
tick boxes have their ticks removed.

Use the Height box to change this setting to 2.6 cm 
and the Width box to 2 cm before clicking on OK.

This will change the aspect ratio (proportions) of the 
image from this:

to this: 

Notice how the second image is slightly thinner but the same height. Save the 
document as task12b. This task is continued in the next section.

Advice
If evidence of an image size or the aspect ratio is required, you can use screenshot 
evidence of this window.

Resize an image using a graphics package
This method is to physically resize the image in a graphics package and then save 
the new image (usually with a new filename). This method has the advantage of 
being able to reduce the file size of an image, which is very useful in helping a 
web page to be downloaded and displayed more quickly. It has the disadvantage 
of using lower resolution images, which can appear pixelated, particularly if you 
wish to enlarge them. The graphics package we will use is called GIMP.

Task 12C
Open the file remora.jpg. Save a copy of this file in your ‘Worked’ folder. Resize 
this file to 80 pixels wide. Save this file as remora1.jpg. Reduce the resolution of 
the image further by downsampling and save the new image as remora2.jpg.

Open your ‘Source Files’ folder in the File Explorer window. Open the ‘Worked’ 
folder in a second copy of the File Explorer window. Click on the file in the 
‘Source Files’ folder, hold down the left mouse button and drag the file from this 
folder into the ‘Worked’ folder.
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12 Images

From the ‘Worked’ folder, open the image remora.jpg in your 
graphics manipulation package. We have chosen GIMP for this 
task. Select the Rectangle Select Tool and use this to lasso 
the image of the remora. Before changing the image size check 
whether the Fixed drop-down menu is set to Aspect ratio.

In GIMP (and many other packages, such as Adobe Photoshop) 
images are resized using the Image tab, followed by Scale 
Image….

This opens the Scale Image 
window. To set the image 
width to 80 pixels, change 
the value in the Width: box.

There is no need to enter 
a height as the image will 
maintain its aspect ratio 
as this had been fixed. To 
change the image size, click 
on the Scale button.

This will alter the size of the image within the package like 
this.

Advice
To intentionally distort an image you would fix the new width 
(or height) using the Fixed drop-down menu and enter a height 
as well as a width for the image.

To save the new image as a JPEG file, select File, then Export 
As... and enter the new filename remora1.jpg before clicking 
on Export. As this image will be saved in JPEG format, you 

are given options on the image quality that you require. These can be 
selected using the slide bar or selecting from the drop-down menu.

1 is the smallest file size that you can have, but also gives the poorest 
quality images. 100 is the highest quality, but results in large file sizes, 
which are much slower to download over the internet.

Resampling an image
This process of changing the image quality is called resampling. Images 
can be downsampled, meaning fewer pixels are used for the image, as 
you have just done by reducing the image quality. Images can also be 
upsampled by adding more pixels. Downsampling reduces the file size and 
therefore makes the web page load more quickly. Export the same image 
again, downsampling the image by lowering the resolution (quality) when 
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12.1 Software tools

saving. This is one method of reducing the colour depth of an image. If you look 
at the files remora.jpg, remora1.jpg and remora2.jpg, you should see their sizes 
have decreased with each stage.

Task 12D
Open the file task12b.

Place the snowman image at the top left of the second paragraph. Ensure that the 
text wraps around both of these images. Save the file as task12d.

12.2.2 Wrap text around an image
Task 12b asks you to place the resized snowball.jpg image at the top right of the 
first paragraph. You are expected to align the image to the margins and to the 
top of the paragraph and there is a further instruction to wrap the text around 
the image. It is better to set the text wrapping first, then place the 
image. Click the left mouse button on the image to select it. This opens 
the Picture Format tab. In the Arrange section, select the drop-down 
arrow next to the Wrap Text icon.

You get a drop-down menu with layout options. Useful ones include:

»	 In Line with Text – this places the image as an in-line graphic which is 
treated as a text character within a line of text. It will move with the 
surrounding text if new text is inserted or deleted.

»	 Square – this places the image on the page and the text wraps (flows) around 
it. Use More Layout Options… to specify the type of wrapping that you 
require.

»	 Tight – this places the image on the page and the text wraps (flows) around 
it, like Square, but you cannot control the distance of the text from the image 
for the top and bottom settings, although you can to the left and right, using 
More Layout Options….

»	 Through – this places the image on the page and the text wraps around the 
image with preset values.

»	 Top and Bottom – this places the image with the text above and below the 
image, but not wrapped to the side.
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12 Images

12.2.3 Place an image with precision
You will be expected to place images precisely. To move and 
place this snowball image, click and hold the left mouse 
button on the image and drag it to the top right corner of the 
first paragraph. There are two methods of placing the image: 
the first is to drag it until the green guidelines appear at the 
top and right side of the image like this.

The second method is to roughly place the image and then 
right click on the image again. Select the Size and Position… 
option to open the Layout window. Select the Position tab.

Set the Horizontal alignment to Right aligned to the Margin.

Set the Vertical alignment to Top aligned to the top of the 
Line of text.

Click the  button to place the image. Check that this 
has worked correctly. If not, this is usually due to the image 
being placed with too little precision when it was dragged 
and dropped. Try dragging and dropping the image again and 
repeat the process.

»	� Behind Text – this places the image behind the text. It can be used to 
set a background image in a document.

»	 In Front of Text – this places an image over the top of the text.
»	� More Layout Options – this can be used to give more options to the 

selected layout types above. For example, if a Square layout is selected 
you can specify where you wish to flow the text around the image and 
the distance of the text from the image on each side. This option also 
allows you to control the positioning of the image on the page.

For this task, set the text wrapping of the image to Tight using the drop-
down menu.

Advice
This menu can also be found by right clicking the mouse on an image and 
selecting Wrap Text.

Advice
Packages like Microsoft PowerPoint will not give text wrap options. Sometimes 
you have to layer objects on the slide or on the page in a document. To do this, 
click the right mouse button on the image and use the options like Bring to 
Front and Send to Back. This is also useful for placing overlapping images in a 
presentation or document.
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Repeat this process to place the resized image of the 
snowman at the top left of the second paragraph like 
this.

12.2.4 Place a border around an image
�Although you have placed the image as specified, 
without a screenshot of the layout window it will not 
be possible to tell that you have placed the image 
correctly as it has a white background. A good tip is 
to place a thin border around the image so that its 
alignment can be seen.

To set a border on the image, click the right mouse button 
on the image and select Format Picture from the drop-down 
menu. This opens the Format Picture pane to the right of 
the document. Click the left mouse button on the Paint 
bucket icon to select the Fill and Line section of this menu.

Click the left mouse button on the triangle for the Line 
section to extend the menu.

Left click on the radio button for Solid line, which again 
extends the options in the pane. Choose a (thin) line Width 
of 0.25pt.

The border now shows the precision placing of the image. 
Save your document as task12d.
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12 Images

Task 12E
Open the file task12d.

The image trees.jpg has been taken on a digital camera. Place this image to the 
right of the table, aligned to the right margin. Resize this image if needed.

Place the image trees.jpg at the end of the document, as shown earlier in the 
chapter. Grab and drag the vertical borders in the table to narrow the column 
widths so that all text shows without wrapping, but no extra white space is 
shown. From this to this.

            

Using the ruler at the top, you can tell that the image will 
need to fit into a space from about 7 cm from the left of 
the page to 16 cm in. This means the image width should be 
about 9 cm wide (16 – 7 = 9). Use the methods learnt earlier 
in this chapter, to resize the image to 9 cm wide whilst 
maintaining its aspect ratio. Set the text wrap so as to allow 
the image to sit to the right of the table. Drag the image 
into the correct position to the right of the table.

12.2.5 Rotate an image
Rotate an image in Microsoft Word
Because the image trees.jpg has been taken using a digital 
camera and saved, the original image is upside down. The 
image could be saved and adjusted in an external graphics 
package, or it can be adjusted in the Format Picture pane 
within Microsoft Word. Click the left mouse button on the 
Pentagon icon to select the Effects section of this menu.

Click on the triangle to open the 3-D Rotation options.

To turn the image upside down, we must rotate the image 
through 180 °. Select the Z Rotation section and use the 
small arrows until the image has been fully rotated.

Save your document as task12e.

Activity 12A
Open the image snowangel.png in a suitable package. Rotate 
the image 90° clockwise. Save the image as snowangel1.png. 
Save the image again as snowangel1.jpg. Show evidence of 
the finished image, the filenames and file sizes.
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End of chapter exam-style questions
Please note that these exam-style questions are from another chapter in this book 
and are for sample purposes.

1	 Which ten computer terms are being described below?
a	 A matrix of filled in dark squares on a light background; read using a 

smartphone camera or tablet using an App.
b	 A device that can read marks written in pen or pencil; the pencil or pen 

marks must be made in the correct position.
c	 An input device that takes physical readings from the surroundings and 

sends the data back to a computer.
d	 An input device that converts sound into electric signals that can be stored 

digitally on a computer.
e	 Device that converts a photograph or document into a computer-readable 

file.
f	 Device used to control the operation of other electronic devices using 

infra-red signals.
g	 Direct data entry device that uses radio waves to read and capture 

information stored on an electronic tag.
h	 Device that produces very high-quality hard copy output; uses dry ink 

cartridges and an electrically charged drum.
i	 A device that prints by impacting a print head made up of an array of pins 

against an inked ribbon.
j	 A printing device that moves around on a surface in an X-Y direction to 

control a cursor on a computer screen.� [10 marks]

2	 a	 i	 Describe how a QR reader works
ii	 What are QR codes used for?� [4 marks]

b	 Give two advantages and two disadvantages of using  
QR codes.� [4 marks]

c	 A touch screen can be used as both an input device and an  
output device. Explain how this is possible.� [2 marks]

3	 Give a use for each of the following input and output devices.
i	 keyboard
ii	 driving wheel or joystick
iii	QR code reader
iv	 barcode reader	
v	 microphone
vi	 touchscreen
vii	3D printer
viii	 dot matrix printer
ix	 RFID
x	 chip and PIN reader� [10 marks]
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